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	1. 1
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	1. 1
	Searching for a Patient

From the Patient Banner, which is always viewable at the top of any page, click the Select Patient drop-down menu.

From the drop-down menu, select Search.  The Select Patient dialog displays.

Enter the patient’s last name and press the [Enter] key.

Double-click on the desired patient.  The patient’s information displays in the Patient Banner.

	
	
	 
	 
	 
	

	2. 2
	Adding Chart Alerts

From the Patient Banner, click the blue “i.”  The Patient Profile dialog displays.

In the Chart Alerts section click the Add Alerts button.  The Add/Edit Patient Chart Alerts dialog displays.

Select the checkbox to the left of the desired item in the Available Items list.

OR Type an alert in the Adhoc Alert field at the bottom of the dialog and click the Add button.

Click OK.  The selected chart alerts display in red text in the Patient Profile dialog.


	
	
	 
	 
	 
	

	3. 3
	Entering Vitals

From the Clinical Toolbar, click the Add New Vitals button.  

If desired, select the problem from the Link to: drop-down menu in the upper-right corner of the dialog for which the vitals are being recorded.

Enter the patient’s vital signs.

Click OK.  The Order Details dialog closes.  The selected item displays in magenta.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	 
	 
	 
	

	4. 4
	Adding Allergies

From the Allergies component on the Clinical Desktop, click New.  The ACI displays with the History Builder and Allergies tabs selected.

Select the associated radio button for the allergen being recorded:  Medication or Non-Medication.

Enter the allergen in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the allergen(s).  The selected allergen(s) display in magenta in the lower-left section of the ACI.

Details (including reactions) for the selected item may be viewed/modified by double-clicking the allergen.

Click OK to return to the Clinical Desktop. 

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	5. 5.
	Viewing the Problems List

From the Clinical Desktop, select the Problem tab.  The Problem component displays with a list of the patient’s problems organized by the default view.


	
	
	
	
	
	

	6. 6.
	Adding a New Problem

From the Clinical Toolbar, click the Add New Problem button.  The ACI displays with the History Builder and Active tabs selected.

If recording a problem other than “Active”, select the tab of the appropriate problem type:  PMH, PSH, Fam Hx or Social Hx.

Enter the problem in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the problem(s).  The selected problem(s) displays in magenta in the upper-left section of the ACI.

Details for the selected item may be viewed/modified by double-clicking the problem.

To add a problem to the patient’s family history, 

indicate the relationship of the problem owner to the patient. If you are unsure of the relationship, click Fam Hx (button, not tab).  

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	7. 7
	Adding a New Hx

Right-click anywhere within the Meds/Orders component.  A menu displays.
Highlight New… from the menu and select the Med Hx option from the sub-menu.  The ACI displays with the History Builder and Med Hx tabs active.

Enter the medication in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the medication(s).  The selected medication(s) displays in magenta in the middle of the left pane of the ACI.

Details for the selected item may be viewed/modified by right-clicking the medication and selecting Edit from the displayed menu.

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	8. 8
	Viewing the Medication List

From the Clinical Desktop, select the Meds/Orders tab.  The Medications component displays with a list of the patient’s medications organized by the default view.

From the Clinical Desktop, select the Meds/Orders tab.  The Medications component displays with a list of the patient’s medications organized by the default view.


	
	
	
	
	
	

	9. 9
	Discontinuing an Rx
From the Clinical Desktop, select the Meds/Orders tab.  The Medications component displays with a list of the patient’s medications organized by the default view.

Highlight the medication to be discontinued.

From the bottom of the component, click D/C.  The selected medication displays in magenta text within the Past Medications list with a status of “Discontinued.”

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	10. 
	Rx Renewal with No Changes
From the Clinical Desktop, select the Meds/Orders tab.  The Medications component displays with a list of the patient’s medications organized by the default view.

Right-click the medication to be renewed.  A menu of actions displays.
From the displayed menu, click Renew.  The selected medication displays in magenta text.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.
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	11. 1
	 Rx Renewal with Changes
From the Clinical Desktop, select the Meds/Orders tab.  The Medications component displays with a list of the patient’s medications organized by the default view.

Right-click the medication to be renewed.  A menu of actions displays.
From the displayed menu, click Renew with changes.  The Medication Details dialog displays.

If necessary, modify the dosage using the drop-down menu in the upper-left corner of the dialog.

Choose the appropriate SIG and instructions.

In the Days field, enter the amount of days supply.  Based on the SIG and instructions, the Qty field should populate with the correct amount.

In the Refill field, enter the number of refills for this medication.

In the next 2 (two) immediate fields, select the appropriate follow-up action from the drop-down menu:  Complete, Evaluate, or Renew and the desired date for the action.

Select the desired Action for the prescription delivery method from the corresponding drop-down menu.

If sending to a pharmacy or calling the prescription in to a pharmacy, select the appropriate location from the Pharmacy drop-down menu.

Click the binoculars to search the master dictionary.

If appropriate, select the Split Rx checkbox and complete the secondary set of fields.

In the Ordered by field, select the authorizing provider for the medication.

If appropriate, in the Therapy area, select the End date for this medication.

Click OK.  The Medication Details dialog closes.  The selected medication(s) displays in magenta in the middle of the left pane of the ACI.

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	 
	 
	 
	

	12. 2
	 Recording Immunization History

From the Clinical Toolbar, click the Add New Problem button.  The ACI displays with the History Builder and Active tabs selected.

Select the Immun Hx tab.  A list of immunizations displays.

Enter the immunization in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the immunization(s).  The selected immunization(s) displays in magenta in the middle of the left pane of the ACI.

Details for the selected item may be viewed/modified by right-clicking the problem and selecting Edit from the displayed menu.

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	 
	 
	 
	

	13. 3
	 Editing Immunizations Entries and Adding Annotations
From the Clinical Desktop, select the Health Management Plan tab.  The Health Management Plan component displays.  

From the View drop-down menu, select Immunization series.  The component displays the patient’s immunization record organized by the default view.

Right-click the desired entry and select Edit from the displayed menu.  The Immunization Details dialog displays.
If necessary, scroll down to the Annotations section.

In the New Annotation textbox, enter a free-text annotation.

Click OK.  The Immunization Details dialog closes.  The selected immunization(s) displays in magenta.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	 
	 
	 
	

	14. 4
	 Creating a New Rx
From the Clinical Toolbar, click the Add New Medication button.  The ACI displays with the Rx/Orders and Rx tabs selected.

Enter the medication in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the medication(s).  The Medication Details dialog displays.

Select the problem from the Link to: drop-down menu in the upper-right corner of the dialog for which the medication is being prescribed.

If an Alternative Medications dialog displays, prescribe as appropriate.

Choose the appropriate SIG and instructions.

In the Days field, enter the amount of days supply.  Based on the SIG and instructions, the Qty field should populate with the correct amount.

In the Refill field, enter the number of refills for this medication.

In the next two (2) immediate fields, select the appropriate follow-up action from the drop-down menu:  Complete, Evaluate, or Renew and the desired date for the action.

Select the desired Action for the prescription delivery method from the corresponding drop-down menu.

If sending to a pharmacy or calling the prescription in to a pharmacy, select the appropriate location from the Pharmacy drop-down menu.

Click the binoculars to search the master dictionary.

If appropriate, select the Split Rx checkbox and complete the secondary set of fields.

In the Ordered by field, select the authorizing provider for the medication.

If appropriate, in the Therapy area, select the End date for this medication.

Click OK.  The Medication Details dialog closes.  The selected medication(s) displays in magenta in the middle of the left pane of the ACI.

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	15. 5.
	Entering Orders
From the Clinical Toolbar, click the Add New Order button.  The ACI displays with the Rx/Orders and Lab/Diag tabs selected.

If not searching for a Lab/Diagnostic order, select the tab of the desired type of order:  Imaging, FU/Ref, Instructions, Immun, Supplies, or Med Admin.

Enter the order in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the orderable item(s).  The Order Details dialog displays.

Select the problem from the Link to: drop-down menu in the upper-right corner of the dialog for which the order is being placed.

Choose the appropriate performing location and communication method in the To Be Performed and Communicated By fields.

In the To Be Done section, select the desired date for the order to be completed.

OR For recurring orders, select the lower radio button and use the Schedule button to establish a schedule for the patient.

Complete any additional billing details as necessary in the lower section.

Click OK.  The Order Details dialog closes.  The selected orderable item(s) displays in magenta in the middle of the left pane of the ACI.

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	16. 6.
	 Entering Orders via QuickSets

From the Clinical Toolbar, click the Add New Order button.  The ACI displays.

Select the Problem-based Orders tab and QSets secondary tab.

From the upper-left pane, select the checkbox to the left of the desired problem.  A list of previously ordered items (orderable items and medications) for the selected problem displays.

Click the checkbox to the left of the desired orderable item(s) and click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	17. 7
	E  Entering Administered Immunizations
Right-click anywhere within the Meds/Orders component.  A menu displays.
Highlight New… from the menu and select the Med Admin option from the sub-menu.  The ACI displays with the Rx/Orders and Med Admin tabs active.

Enter the medication in the search field.  The selected list filters as text is entered to create a string of search results.

Click the binoculars to search the master dictionary.

Once identified, click the checkbox to the left of the medication(s).  The Medication Details page displays.

Select the problem from the Link to: drop-down menu in the upper-right corner of the page for which the medication is being administered.

Choose the appropriate SIG and instructions.

In the To Be Done: field, select the appropriate radio button and complete appropriately.

In the Ordered by field, select the authorizing provider for the medication.

If appropriate, in the Therapy area, select the End date for this medication.

From the Prospective drop-down, choose the appropriate option.

From the top of the page, select the Record Administration tab.

Complete all fields as appropriate on the Record Administration tab.

Click OK.  The Medication Details page closes.  The selected medication(s) displays in magenta in the middle of the left pane of the ACI.

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	18. 8
	     Entering Visit Charges
From the Visit Charge Selector page, select the desired view from the View drop-down menu.

Enter the type of visit charge or CPT code in the search field and click the Go button.  A list of search results displays.

Select the appropriate visit charges.  The selected item(s) display in the lower section of the Visit Charge Selector page.

Select the checkbox(es) of the desired modifiers in the Modifier Group section if needed.

If necessary, modify the linked diagnoses using the available checkbox(es) in the Diagnosis section.

Clicking the Charge Details button also enables Charge Modifiers and linked diagnoses to be added/modified as necessary.

The E/M Expert button may be used to generate the appropriate visit code.  This tool guides the user through a series of steps assessing each aspect of the patient’s encounter.

To remove a visit charge, highlight it from the list at the bottom of the page and click the Remove button.

Click the Next button.  The Procedure Charge Selector page displays.


	
	
	
	
	
	

	19. 9
	E   Entering Procedure Charges
From the Procedure Charge Selector page, select the desired view from the View drop-down menu.

Enter the type of procedure charge or CPT code in the search field and click the Go button.  A list of search results displays.

Select the applicable procedure charges.  The selected item(s) display in the lower section of the Procedure Charge Selector page.

Select the checkbox(es) of the desired modifiers in the Modifier Group section if needed.

If necessary, modify the linked diagnoses using the available checkbox(es) in the Diagnosis section.

Clicking the Charge Details button also enables Charge Modifiers and linked diagnoses to be added/modified as necessary.

The Covered Diagnoses button may be used to verify it the selected procedure meets the Medicare Rules administered by Medicare Part B.

To remove a procedure charge, highlight it from the list at the bottom of the page and click the Remove button.

Click the Next button.  The Encounter Form page displays.


	
	
	
	
	
	

	20. 
	 Accessing the Daily Schedule
From the Menu, select Schedule.  The Daily Schedule page displays.

Select the appropriate provider from the Provider drop-down menu on the Daily Schedule page.
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	21. 1
	  Viewing Multiple Provider Schedules
From the Menu, select Schedule.

From the Tabs, select Provider Schedules.  The Provider Schedules page displays with 4 providers’ schedules displayed simultaneously.


	
	
	 
	 
	 
	

	22. 2
	Accessing a Patient Profile

From the Patient Banner, click the blue “i” icon.  The Patient Profile dialog displays with the selected patient’s profile information.


	
	
	 
	 
	 
	

	23. 3
	Adding Pharmacy Information
From the Patient Banner, click the blue “i.”  The Patient Profile dialog displays.

Scroll to the PBM/Pharmacy section.

Click on the binocular to search for Pharmacy/Mail Order.  

Enter the desired search criteria in the appropriate fields and click Search. The results of the search displays.

Double-click the desired pharmacy. The pharmacy information displays in the Pharmacy/Mail Order section of the patient’s profile.

	
	
	 
	 
	 
	

	24. 4
	Show/Hide Clinical Toolbar
To hide the Clinical Toolbar, click on the red X in the upper-right corner.

To show the Clinical Toolbar, click the Tools menu option located in the Toolplace.

From the Tools menu, select Show/Hide Clinical Toolbar. The “floating” Clinical Toolbar displays.


	
	
	
	
	
	

	25. 5.
	 Viewing the Clinical Desktop

From the Menu, select Chart.  The Clinical Desktop displays.

Select the desired tab within a component.  The associated items display.


	
	
	
	
	
	

	26. 6.
	 Accessing ChartViewer
From the Menu, select Chart.  The Clinical Desktop displays.

Select the ChartViewer tab in the associated component.  The patient’s chart items display.

Select the appropriate view from the View drop-down menu.  The recommended view is All by Section by Sub-Section.

Double-click the appropriate document to view in a separate window
Click Print at the bottom of the component to view a print menu:


	
	
	
	
	
	

	27. 7
	 Filtering within the ChartViewer
After accessing the ChartViewer, select the appropriate view from the View drop-down menu.

Click the Quick Filter button to filter a list of desired records.  A Search field displays with a list of filtering options.

Click one or more category drop-down arrows to narrow the list of chart items further.  Select the desired option from the drop-down menu(s) as needed.


	
	
	
	
	
	

	28. 8
	C Creating Custom ChartViewer Views
From the top of the ChartViewer component, click the Edit View button. The ChartViewer – View Editor dialog displays.

From the Add/Edit Views tab, click the New button to the right of the View field.

From the View text entry field, enter a new name for the custom chart view.

From the Group By fields, group the documents in the chart by Section and Subsection in ascending (ASC) order.

From the Column Sort field, select the preferred method of sorting the grouped documents in descending (DESC) order.  The recommended sorting is Encounter or Owner.

From the Filters section of the ChartViewer – View Editor page, click the desired tab(s) and complete as necessary.

From the bottom of the dialog, select the checkbox to the left of Save as Default if desired.

Click the Save button.  The ChartViewer component displays.

From the View drop-down menu at the top of the ChartViewer component, select the newly created custom chart view.  The documents display per the settings of the custom chart view.


	
	
	
	
	
	

	29. 9
	 Creating a Favorites List
From the ACI page, highlight the “favorite” item from the Specialty List.

Right-click on the highlighted item.  A menu displays.
To add the highlighted item to the My Favorites List, select Favorite Item.

The favorite items display when My Favorites is selected as the search list.


	
	
	
	
	
	

	30. 
	 Viewing Flowsheets
From the Clinical Desktop, select the Health Management Plan tab.  The Health Management Plan component displays the patient’s HMP organized by the default view.

Click the Full Screen button in the upper-right corner of the Clinical Desktop.  The Health Management Plan component displays in expanded form.

From the View drop-down menu, select Flowsheets.

Select the desired department from the third drop-down menu in the upper-middle portion of the component.

From the Flowsheets menu, select the desired flowsheet to view.  The flowsheet displays within the component.
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	31. 1
	 Graphing Information
From the Clinical Desktop, select the Health Management Plan tab.  The Health Management Plan component displays the patient’s HMP organized by the default view.

Place a check mark in the appropriate checkboxes and click the Graph button.


	
	
	 
	 
	 
	

	32. 3
	 Viewing the Encounter Summary
From the Clinical Toolbar, click the Encounter Summary button.  The Encounter Summary displays.

To remove an item, select the checkbox to the left of the desired item in magenta.  The checkmark is removed from the associated checkbox.

To modify an item, right-click on the desired item and select the appropriate action from the displayed menu.

When the clinical intake is completed, change the patient location and status on the Clinical Toolbar.


	
	
	 
	 
	 
	

	33. 4
	Personalizing the Clinical Desktop
From the Clinical Toolbar, click the arrow to the far right.  A menu displays.  

Select Personalize from the menu.  The Personalize dialog displays.

Select the tab of the desired area within the Clinical Desktop and choose the desired default settings.

Click the Save button.  The Clinical Desktop displays reflecting the personalization settings.


	
	
	
	
	
	

	34. 5.
	 Adding Structured Notes
From the Clinical Toolbar, click the Note button and select Start New Note from the drop-down menu.  The Note Selector displays.

From the Style field, select the Note radio button.

From the Specialty drop-down menu, select the appropriate option.

From the Visit Type drop-down menu, select the appropriate type of visit the current note will be used to document.

Verify the name of the user who will be finalizing the document is displayed within the Owner field.  If necessary, use the binoculars to search for the appropriate owner.

To add a chief complaint, select the Add/Remove Chief Complaints hyperlink.  The ACI displays with the History Builder and Chief Complaint tabs selected.

Enter the chief complaint in the search field.  The selected list filters as text is entered to create a string of search results.

Once identified, click the checkbox to the left of the chief complaint(s).  The selected chief complaint(s) displays in magenta in the upper-left pane of the ACI.

Click OK to return to the Note Selector.  The Chief Complaint(s) display in the lower portion of the Note Selector.

Click OK.  The Note Authoring Workspace (NAW) displays.

To change the Note Type, click the drop-down arrow next to the note type and select a new note type from the menu.

Select a section in the Table of Contents.

Document the selected note section using the associated controls.  See table below for control descriptions.

Click Save when finished.

OR Click Save & Close to save the current note and exit out of the Note Authorizing Workspace.


	
	
	
	
	
	

	35. 6.
	 Adding/Removing Note Forms
Right -click the desired form to be removed or added from the Table of Contents.  A menu of actions displays.
Select Delete Form to remove the selected form from the current note.

OR Select Clear Form to clear the information from the selected form.

OR Select Add Form Above or Add Form Below to insert a new form in the desired location.  The Form Selector dialog displays.

Enter the desired form in the search field and click the binoculars to search the master dictionary.  The search results display.

Once identified, click the checkbox to the left of the form and click OK.  The selected form displays within the designated section of the note.


	
	
	
	
	
	

	36. 7
	 Using Degree Indicators
From the displayed form, select the degree indicator to the right of the desired clinical item.  The Details dialog displays.

Complete the pertinent information displayed in the Detail dialog using the available controls.

When finished, click the OK button to exit and return to the Note Authoring workspace.


	
	
	
	
	
	

	37. 8
	 Using a Text Template
From the Note Authoring Workspace, select a section in the Table of Contents that offers a text template as an input option.

From the list, select the text template that is associated with the visit.

OR Type directly into the text template panel on the left.

Double-click items within [brackets] to select and enter the required data into the template.
Add additional information by typing directly into the free text area of the template.

If needed, click the Spell Check button after completing the template.

Click Push.  The information displays in the bottom section of the note.


	
	
	
	
	
	

	38. 9
	 Including Images in a Note Section
Right-click the desired Note Section in the Table of Contents located on the left-hand side of the workspace.  A menu displays.
From the displayed menu, select Add Image Top or Add Image Bottom as desired.  The Image Selector dialog displays.

Enter the desired anatomical image in the search field and click the binoculars to search the master dictionary.  The search results display.

Once identified, click the checkbox to the left of the image and click OK.  The selected image displays within the designated section of the note.

Select the desired drawing tool(s) from the toolbar displayed above the image.

Drag the mouse on the image to add the necessary markups.

If necessary, type comments in the Comments field located in the bottom portion of the section.

Click Commit to save the image with mark-up and any associated comments.


	
	
	
	
	
	

	39. 
	 Assessing a Problem
Select Assessment in the Table of Contents located on the left-hand side of the workspace.  The patient’s active problem list and any associated diagnosis forms display.

Select the checkbox to the left of the assessed problems.  The problems display in magenta in the “Assessed” list.

If the problem is unavailable, search for and select a new problem using the Clinical Toolbar or the New button on the action menu below the active problem list.


	
	
	
	
	
	

	40. 
	 Output Documents
To view and sign an output document (s), check the appropriate document (s) and click View.  The document (s) display.

Use the arrow indicators to navigate from one output document to another.

Add annotations by typing directly into the New Annotation field.

Click the Sign button. The system prints based on auto-print defaults.
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	41. 1
	 Completing a Note
Click the Sign button. The Note Signature dialog displays.

Enter the appropriate assigned Password.

Select the appropriate Sig Type from the drop-down list.

Click the OK button.


	
	
	 
	 
	 
	

	42. 3
	 Viewing a Health Management Plan
From the Clinical Desktop, select the Health Management Plan component.  The patient’s HMP displays.

Select the desired view from the drop-down menu in the upper-left of the component.  The table below describes the available HMP views.


	
	
	 
	 
	 
	

	43. 4
	 Using CareGuides
Search for and select a new problem from the ACI.  The problem displays in magenta within the pane in the upper-left.

OR From the ACI, select the checkbox of the existing Active problem within the pane in the upper-left.

Click the CareGuide button.  A list of associated CareGuides displays.

Select the appropriate CareGuide from the list.  The contents of the template display within the CareGuide secondary tab of the ACI.

Select the checkbox to the left of the desired items to be ordered.

Use the radio buttons above the CareGuide to display specific types of items available:

Click OK to return to the Clinical Desktop.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	44. 5.
	 Entering Results
From the Clinical Desktop, select the Meds/Orders component.

Right-click the desired order to be resulted and select Enter Result from the displayed menu.  The Order Details dialog displays with the Results tab selected.
In the Collected/Examined field select the desired date and time using the Select Date and Time button.

OR Click the Now button to enter the current date and time.

Complete the Performing Location and Performed By fields, as appropriate.

In the Results Item(s) section enter the value for each order component.  Include a flag, reference range, and stage for each result component, as necessary.

Click OK.  The Order Details page closes.  The selected order displays in magenta.

To save, click Commit on the Clinical Toolbar.  Magenta text changes to black.


	
	
	
	
	
	

	45. 6.
	 Viewing Results
From the Clinical Desktop, select the Health Management Plan component.  

OR From the Clinical Desktop, select the ChartViewer component.  

OR From the Clinical Desktop, select the Meds/Orders component.  

Double-click the desired result or resulted order.  The Order Viewer displays with the details of the selected item.

	
	
	
	
	
	

	46. 7
	 Entering a Diagnosis for a Charge
Search for and select a patient.  Once in context, select the appropriate patient encounter. 

OR Select a patient from the Daily Schedule.  

From the Menu, select MD Charges.  

From the Tabs, select Diagnosis.  The Diagnosis Selector page displays.

From the View drop-down menu, select the appropriate view.  Select Patient Past Diagnoses when entering charges for previously selected diagnoses.

Enter the diagnosis name or ICD9 code in the search field and click the Go button.  A list of search results displays.

From the search results, select up to four (4) diagnoses.  The selected item(s) display in the lower section of the Diagnosis Selector page.

To set a diagnosis as primary, highlight the item from the list at the bottom of the page and click the Set Primary Dx button.

To remove a diagnosis, highlight it from the list at the bottom of the page and click the Remove button.

Click the Next button.  The Visit Charges Selector page displays.


	
	
	
	
	
	

	47. 8
	  Submitting the Encounter Form
From the Encounter Form page, ensure the appropriate information is entered for Billing Provider, Performing Provider, Referring Provider, Billing Area and Location fields.

Click the face icon.  The Charge Edits page displays a list of missing information or warning related to the selected charge.

Click the link and make the necessary changes from the Charge Detail   page.

OR Close the page and edit the diagnosis or the charge code on the encounter form.

Click the Submit button when finished.  The status changes to “Submitted”.  Once charges have been entered they are indicated by a dollar sign icon .


	
	
	
	
	
	

	48. 
	 Changing Sites
From the Menu, select Site.  The Site page displays

From the bottom of the Site page, click the Select Site button.  The Site Selector page displays.

From the Site Selector dialog, double-click the appropriate site location.  The new location displays on the Site page.
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	49. 1
	Personalizing Pages
From any page where available, click the Personalize link.  The Personalize page displays.  

Choose the desired default settings.

Click the OK button.


	
	
	 
	 
	 



